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Program Features 
 
COMPONENT RELIABILITY:  WeibPar interacts with CARES to calculate effective volumes or 
areas, as well as computing confidence bounds on component reliability through bootstrap 
techniques.  The user must be in possession of the CARES (Ceramics Analysis and Reliability 
Evaluation of Structures) algorithm to perform these computations.  The CARES program 
evaluates the structural reliability of components consisting of brittle materials. 
 
 
TIME INDEPENDENT PARAMETER ESTIMATION (Fast Fracture Weibull Parameter 
Estimation):  WeibPar estimates parameters for both the two and three parameter Weibull 
distributions from uncensored failure strength data.  The program displays, both numerically and 
graphically, the maximum likelihood parameter estimates as well as the linear regression 
parameter estimates.  Regarding the failure data, the user is prompted for the flaw type, volume 
or surface, as well as the specimen geometry.  Current geometries include tensile specimens 
and bend bar specimens.  Direct input of the effective volume or area is available for cases 
when the user calculates the effective volume or area outside of WeibPar.  Additionally, 
WeibPar will utilize a finite element model of the specimen geometry to calculate the effective 
volume or area. 
 
The linear regression estimation algorithm and the plotting routines require a data ranking 
formula.  Multiple ranking formula schemes are available as a user option.   
 
Unbiasing factors and confidence bounds are provided on the two parameter maximum 
likelihood estimates.  One set of the bounds is calculated based on the Thoman, Bain and Antle 
procedure.  For this procedure Monte-Carlo techniques were utilized to derive tables of 
unbiasing factors and confidence bound factors.  The second set of confidence bounds is 
calculated by the likelihood ratio hypothesis test.  An additional graphic is provided with this 
method that shows the confidence “ring” around the parameter estimates.  A third set of 
confidence bounds is calculated based on bootstrap techniques. 
 
WeibPar uses two parameter maximum likelihood estimation techniques to estimate parameters 
for censored data.  Censored data is failure data where each data point has been associated 
with a flaw type such as volume or surface.  Confidence bounds are calculated for censored 
data via the Bootstrap technique. 
 
WeibPar calculates pooled Weibull parameters from multiple uncensored data sets of different 
geometries for either volume or surface flaws. 
 
 
TIME DEPENDENT PARAMETER ESTIMATION (Fatigue Parameter Estimation):  WeibPar 
estimates time dependent parameters from dynamic fatigue data through linear regression 
techniques.  Combined with fast fracture (or Weibull) parameters and the specimen geometry, 
the time dependent material parameters are calculated.  A CMP file may be created for use in 
the CARES program via the Export results function.   
 
 
DATA SET GENERATION:  Uncensored randomly generated data sets may be created based 
on the user's input of Weibull parameters and the number of data points.  The data sets are 
created through Monte-Carlo techniques.  The generated data sets may be saved to a file. 
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PRINT, EXPORT:  These functions are available from the File menu and allow the user to print 
the chart or the estimated parameters and export the chart to different file formats such as 
JPEG, Bitmap or Metafile.  Two formatted text files, WPR and CMP, may be created through 
the export results function.  The WPR format includes all plotting information necessary for use 
in other graphics packages.  The CMP file, CARES material parameter file, includes 
appropriately formatted material parameters for use in reliability analysis. 
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Installation 
  
This 32-bit program has been designed for Windows XP.  The program has additionally been 
tested under Windows NT, 2000, and XP 64-bit.  The program has also been updated for the 
German and Italian versions of Windows XP. 
 

1. Unzip the zip file into an empty subdirectory. 
 

2. Double click on SETUP.EXE.  The SETUP program will guide you through the 
installation sequence. 

 
3. The SETUP program prompts for an installation directory. 

 
C:\Program Files\CRT Inc\WeibPar 4.0\ 

 
is the recommended directory.  This directory will be referred to as <InstallDir>. 

 
The files and directory structure after installation: 
 
Subdirectory File Description 
<InstallDir>\bin WeibPar.exe Main Program 
 Unbias.sup Table of unbiasing factors for the 

MLE2 estimates. 
 CFAlpha.sup Table of Confidence Bounds factors 

for the MLE2 Weibull modulus. 
 CFBeta.sup Table of Confidence Bounds factors 

for the MLE2 Weibull characteristic 
strength. 

<InstallDir>\examples\… examples Example files described in the 
Examples section. 

<InstallDir>\docs Guides User Guides, Theory Guides, License 
<InstallDir>\license GetClientInfo.exe 

Readme.txt 
Licensing Files 

 
 
 

Uninstall 
  
From the Windows Control Panel click à Add/Remove Programs. 
 
Within the Add/Remove Programs Properties select WeibPar 4.x and click the Remove button.  
Some files and the directory structure require manual deletion. 
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Licensing 
 
WeibPar requires a valid license.  When a valid license does not exist some of the program 
functions are limited.  The license will allow program use on a single computer for any local 
(non-network) user of that computer. 
 
NOTE:  WeibPar is licensed for SINGLE computer use. 
 
Once the program has been installed follow the steps below to license the program: 
____________________________________________________________________________ 
 

N E W    I N S T A L L  --  New License Required 
____________________________________________________________________________ 
 

1. Initiate the Licensing process. 

WeibPar menu:  [Help | License | Client Information] 
 

The following file will be created and displayed: 
 

C:\Program Files\CRT Inc\WeibPar 4.0\license\WeibParClientInfo.txt 
 

2. Email  “WeibParClientInfo.txt”  to   License@WeibPar.com 
 

3. Upon validation, the License File “WeibParLicense.txt” will be returned to you.  
Place it in the following directory: 

 
C:\Program Files\CRT Inc\WeibPar 4.0\license\WeibParLicense.txt 

 
____________________________________________________________________________ 
 

U P G R A D E   I N S T A L L  --  Existing License 
____________________________________________________________________________ 
 
Except when otherwise noted, your existing License will work with each program upgrade. 
 

1. Copy the file “WeibParLicense.txt” from your previous WeibPar installation. 

2. Paste the license file into the following directory: 
 

C:\Program Files\CRT Inc\WeibPar 4.0\license\WeibParLicense.txt 
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Program Execution 
 

1. Click Start Menu à Programs à WeibPar 4.x 
 

In this location you will find shortcuts to WeibPar, the User Guide, the Theory Guides, 
and the License agreement. 

2. Use the "File | Open" menu commands or click on the "Open" icon to open a data file.  
An Open dialog box will appear allowing the user to select the input data set file. 

 
Choose one of the example data files such as 

  
<InstallDir>\examples\fast\Uncen.dat 

3. The file will be scanned for censoring information and the appropriate uncensored or 
censored dialog will appear. 

 
Uncensored Time Independent Data: – The user may set: 

a. Specimen Geometry 
i. (None) 
ii. Tensile Specimen 
iii. 3 pt. Bend Bar Specimen 
iv. 4 pt. Bend Bar Specimen 
v. Pure Bend Specimen 
vi. User Input Effective Volume or Area 
vii. Finite Element Model (requires CARES) 

b. Flaw Type of Volume or Surface for ii – vii above 
c. Confidence Level 
d. Whether to calculate the Bootstrap bounds 

 
If the Advanced button is clicked the user may also  

e. Set the Data Ranking Formula 
f. Analyze J – Integral (JC) data 
g. Analyze Fracture Toughness (K1C) data 
h. Set the Temperature 
i. Fix the Weibull Modulus 
j. Fix the Weibull Threshold 

 
Censored Time Independent Data: – The user may enter specimen geometry 

information and the type of analysis (Volume, Surface, or Unknown) for each 
censored data set.  Confidence Level, Bootstrap calculation, and the Data Ranking 
Formula options are also available. 

 
Uncensored Time Dependent Data: – In addition to setting the specimen geometry 

and flaw type as described above, the user also sets the Time Independent or 
Weibull parameters.  When a Weibull parameter file is open previous to opening the 
fatigue data, the “From Fast Fracture Data” option will be available.  Otherwise the 
User Input option is always available. 

4. Upon opening a valid input file, WeibPar calculates all relevant Weibull parameters or 
Fatigue parameters, and automatically displays and graphs the results. 
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5. Multiple data sets may be opened at the same time.  Use the "Window" menu for 
common Multiple Document Interface (MDI) functions. 

6. When the user opens multiple uncensored time independent data sets, the “Pool” button 
may be used to calculate the pooled two parameter maximum likelihood estimates 
(PMLE2).  The first data set with specimen geometry will determine whether a volume or 
surface pooled analysis will be performed.  All valid uncensored data sets of the same 
flaw population will be pooled. 
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Data Sets 
 
General Structure 

• Data files utilize the *.DAT or the *.TXT extension and are in the format of ASCII 
text files (same as *.txt). 

• Blank lines and comment lines beginning with a "C" are allowed. 
 
Time Independent Data:  Also known as fast fracture data, this data typically consists of failure 
stresses unassociated with time information.  Brittle materials fast fracture data is typically 
characterized by the Weibull distribution. 
 
Uncensored Time Independent Data 

• A single column of failure values 
• Blank lines and comment lines are acceptable. 

 
C An example Uncensored data set 
 
411 
429 
431 
434 
435 
etc ... 

 
Censored Time Independent Data 

• Two columns 
o First column contains the failure values 
o Second column specifies the censored group indicator for that failure value.  The 

indicator may be of any character or numeric string (no spaces or special 
characters).  If the string begins with an ‘V’ or an ‘S’ than that set will be 
designated as a volume or surface type flaw for subsequent assigning of 
specimen geometry.  For example, volume, vol, vol1, vol2, etc. 

• The columns may be separated by any number of spaces, tabs, or commas. 
• Blank lines or comment lines are acceptable. 

 

C An example Censored data set 
 
416   sur2 
458   vol1 
520   sur2 
527   sur2 
546   vol1 
561   sur2 
572   vol1 
etc ... 
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Pooled Time Independent Data 
 
Uncensored time independent data sets as described above are utilized for the pooled data 
algorithm.  All uncensored data sets open within WeibPar with the same flaw type are included 
in the pooled set when the pooled data function is initiated. 
 
 
 
 
Time Dependent Data:  This data typically consists of failure stresses along with information 
relating to time (e.g., time to failure, stressing rate, etc.). 
 
Uncensored Time Dependent Dynamic Fatigue Data 

• First Line must be “DYNAMIC FATIGUE” 

• Two columns 
o First column contains the Stress Rates in units such as  Mpa/s  or  psi/s. 
o Second column contains the failure values 

• The columns may be separated by any number of spaces, tabs, or commas. 

• The values do not have to be sorted in any particular order.  WeibPar will sort them first 
by the stress rate and then by the failure values. 

• Comment lines begin with a “C” 

• Blank lines are allowed 
 

 
 
 

DYNAMIC FATIGUE 
 
C An example Dynamic Fatigue data set 
 
30 336.6 
30 437.7 
30 520.5 
  
0.3 336.7 
0.3 353.7 
0.3 520.4 
0.3 541.8 
  
0.003  403.2 
0.003  437.6 
0.003  444.0 
etc ... 
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Program Use 
 
Menus 
 

• File 
o Open Displays the Open File Dialog, used to open data files. 
o Save Data Displays the Save File Dialog, used for saving a data file 

under a different name or to save Monte Carlo generated data. 
o Close Closes the active data set window. 
o Print Prints the contents of the window for the active tab of the 

active data set. 
o Export Results WPR – Saves the parameter estimates and the plotting 

information to a formatted text file. 
  CMP – Saves the material parameter estimates to a formatted 

text file for use with the CARES program. 
o Export Graph Allows the users to export the active chart to a Bitmap, 

Metafile, Enhanced Metafile or JPEG file. 
o [Files] A list of previously opened files that may be used to reopen 

those files. 
o Exit Exits the application. 

 
 

• Tools 
o Recalculate Redisplays the Data Type dialog for reanalysis of a data set. 
o Generate Data Opens the Generate a Data Set dialog.  Uses the Monte-Carlo 

technique to randomly generate time independent data sets 
according to user input Weibull parameters. 

o Pool Data Calculates the pooled parameter estimates given all open 
Uncensored Time Independent data sets of the same flaw 
type. 

o CARES Interface Displays the CARES Interface window that provides advanced 
feature interaction with the CARES program. 

o Set CARES.EXE… Creates the link to the CARES program. 
 
 

• Window 
o Hide Parameters This function toggles whether the left hand data view screens 

are shown or hidden. 
o Tile Tiles the open child windows 
o Cascade Cascades the open child windows 
o Arrange Icons Arranges all minimized child windows to the bottom left of the 

Main window. 
 
• Help 
o User Guide Displays the User Guide PDF (Adobe Acrobat required). 
o Fast Fracture Displays the Time Independent Theory Guide PDF. 
o Time Dependent Displays the Time Dependent Theory Guide PDF. 
o Ceramic Reliability Open a Web browser and links to CeramicReliability.com. 
o Program Updates Open a Web browser and links to the download section of 

WeibPar.com. 
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o Update Guides Open a Web browser and links to WeibPar.com where the 
most current versions of the guides may be downloaded. 

o Support Opens a Web browser and links to WeibPar.com where 
support information may be reviewed. 

o Terms Of Use Opens the CRT Terms of Use Agreement. 
o License – Directions Opens the License Readme.txt file that contains the step-by-

step instructions for licensing the program. 
o License – Client Info Creates the WeibPar Client Information file necessary for 

License generation. 
o About Displays the splash screen that includes version information. 

 
 
Buttons 
 

• Open Displays the Open File Dialog, used to open data files. 
• Save Displays the Save File Dialog, used for saving a data file 

under a different name or to save generated data. 
• Print Prints the contents of the window for the active tab of the 

active data set.  Used for either text pages or graphs. 
• Recalculate Redisplays the Data Type dialog for reanalysis of a data set. 
•  
• Pool Data Calculates the pooled parameter estimates given all open 

uncensored data sets of the same flaw type. 
• CARES Interface Displays the CARES Interface window that provides advanced 

feature interaction with the CARES program. 
• Generate Data Opens the Monte Carlo dialog, used to generate random data 

sets according to user input Weibull parameters. 
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Windows and Dialogs 
 
Main Window – Main application window.  This window contains the menu system, the button 
icons, the child windows (Data File window and Pooled Data Window), and when [ Window | 
Hide Parameters ] is not checked the top left window pane shows the parameter estimates for 
the active data file and the bottom left window pane shows the failure data.  For censored data 
sets the Data pane will split the groups of data into separate columns. 
 

 

The main window and all its components are sizeable.  The program will track and restore the 
user’s settings (sizes and positions). 

 



WeibPar User’s Guide  Connecticut Reserve Technologies, Inc. 
 

 
March 2006  Page 14 

Analysis Options Dialog – Time Independent: This dialog is displayed after opening a data 
file or updating  (reanalyzing) a data file.  The program recognizes whether the data set is 
uncensored or censored and configures itself accordingly. 

 

Use the Advanced and Simplified buttons to reveal or hide the advanced options. 

For uncensored data sets the user has a choice of failure data, J Integral data or Fracture 
Toughness (KIC) data.  Failure Data additionally consists of the following types:  Raw data, 
Tensile specimen, 3 Point Bend Bar specimen, 4 Point Bend Bar specimen, Pure Bend 
specimen, and a User option of directly inputting the Effective Volume or Area.  As each of 
these specimen types are selected the user is prompted for the appropriate dimensions and the 
type of flaw that the data set represents. 

The Confidence Level allows the user to choose which level to calculate the confidence bounds 
for the Exact method (from the Thoman, Bain, and Antle tables), the Likelihood Ratio method 
based on the χ2 distribution, and the Bootstrap method. 

The Data Ranking Formula option is used both in the plotting of the data sets and in the linear 
regression estimator algorithm. 

The J Integral and Fracture Toughness (KIC) data represent special cases where the Weibull 
moduli are fixed known values, 2 and 4 respectively.  The user may additionally choose to have 
the parameter estimates for a data set calculated given either a fixed Weibull Modulus or a fixed 
Threshold value. 
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Analysis Options Dialog – Time Dependent:  For time dependent data the specimen 
geometry section is the same as described above.  Note that the following discussion 
references a specific type of time dependent data, i.e., dynamic fatigue (or the application of a 
monotonically increasing load until failure). 
 

 
 
The Weibull parameters section is used in conjunction with the specimen geometry to calculate 
the time dependent material parameters.  Without the fast fracture parameters, the calculated 
time dependent parameters are specimen specific not material specific. 
 
To link the fast fracture parameters from a data set: 

1. First open and evaluate the fast fracture data set. 
2. Next open a time dependent data set.  The “From Fast Fracture Data” option will be 

available. 
 
Notes:  If multiple fast fracture data files are open the “active” window will be linked.  To link to 
another fast fracture data file, the time dependent data set must be closed and reopened. 
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Weibull Data File Window – For each fast fracture data set that is opened, a Weibull Data File 
Window will be displayed. The Filename is listed across the top border of the window.  The tabs 
located below the top border contain information regarding the parameter estimation results. 

 

The ‘Weibull Plot’ tab displays a graphical representation of the data set and its parameter 
estimates.  Options for this plot include hiding and showing particular parameter estimates 
and/or the failure data.  In the example above, along with the failure data, the biased MLE 2 or 
maximum likelihood two parameter estimates (blue straight line) and the MLE 3 (blue curve) are 
shown along with the Bootstrap confidence bounds. 

Additional plotting options include the two parameter linear regression line, the unbiased MLE 2 
line, MLE2 Bootstrap line estimate, the three parameter linear regression line, and when the 
user supplies a fixed threshold value the LIN 3 fix and MLE 3 fix lines will also be available. 

 

Use the  icon to edit the chart.   

The Chart title, the X-axis title, and the 
minimum and maximum values for the X-axis 
may be modified.  The X-axis values must 
encompass the data. 

Clear the entry to reset any of the values to 
their defaults. 
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The ‘Parameters’ tab contains a printout of the calculated statistics along with the geometry and 
other options that were setup in the Analysis Options dialog for this data set.  The parameters 
are described below.  For further details please refer to the Time Independent Theory Guide. 
 
M, Sig Not, Char Str Weibull Slope, Weibull Material Scale, and Characteristic Strength 

parameters respectively. 
 
k, Eff Specimen Geometry Constant and Effective Volume (or Area) 

typically signified by kV (or kA). 
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LIN2, LIN3, LIN3f Linear Regression estimation for 2 parameter, 3 parameter and 3 
parameter with a fixed threshold. 

 
MLE2, MLE3, MLE3f Maximum Likelihood estimation for 2 parameter, 3 parameter and 3 

parameter with a fixed threshold. 
 
Bain, Boot, Ratio Upper and Lower confidence bounds on the parameter estimates 

from the Bain, Antle, Thoman tables, from the Boostrap technique, 
and from the Likelihood Ratio technique. 

 
LNL, SSR Natural Log of the Likelihood and the Sum of the Squared Residuals. 
 
R, A2, OSL Regression Coefficient, Anderson Darling, Significance Level 
 

 
 
The ‘Parameter Bounds’ tab shows the confidence bounds around the parameter estimates.  In 
this case there is 95% confidence that the true population parameters fall within the bounds.  
The ring was calculated by the Likelihood Ratio technique.  The rectangle was calculated via 
the Bain, Antle, Thoman confidence tables.  The extremes of these bounds are reported on the 
‘Parameters’ page discussed previously. 
 
The ‘Weibull Parameter Values’ reveals the Weibull parameters for the current mouse location 
as the user moves the mouse over the graph. 
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The ‘Histogram/PDF’ tab shows the histogram for the data set, the probability density function 
(PDF) for the normal distribution, and the PDF for each of the Weibull distribution estimates.  
Once again the user can choose which components to hide and which to show.  Above the 
histogram, the normal PDF, the LIN2 PDF, and the MLE3 PDF are plotted. 
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Pooled Data Window – The pooled data windows displays the results of pooling multiple 
Uncensored data sets that are of the same flaw type (volume or surface).  The technique for 
pooling data utilizes the maximum likelihood estimation for two parameter Weibull distributions.  
The following screen shots demonstrate the pooling of three data sets each containing 18 
failure stresses.  The first two data sets are three point bend bar data with two different 
geometries.  The third data set is four point bend bar data with a third geometry. 

 
 
The ‘Pooled’ tab shows the result of transforming the pooled failure data each according to its 
own geometry into the geometry independent space.  In this space the pooled data may be 
plotted as one data set against the estimates of the Weibull modulus and the material scale 
parameters. 
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The ‘Individual’ tab displays the three data sets in the geometry dependent space.  The 
estimated lines each share the common slope of the pooled Weibull modulus.  The unique 
characteristic strength values are a function of the pooled material scale parameter, the pooled 
modulus, and the geometry of each data set. 
 
 

 
 
The ‘Weibull Modulus’ tab shows the individual data set Weibull moduli with error bars based on 
the likelihood ratio confidence bounds.  The solid horizontal line is the pooled Weibull modulus 
with its confidence bounds represented by the dashed horizontal lines.  The confidence bounds 
on the pooled modulus are tighter than the individual data set bounds because there is more 
data (54 points) in the pooled data set. 
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The ‘Scale Parameter’ tab plots the individual data set scale parameters against the pooled 
scale parameter.  Confidence bounds for the individual data sets were calculated on the 
characteristic strength parameter.  These confidence bounds cannot be readily transformed into 
confidence bounds on the individual data set scale parameters; therefore, error bars 
representing confidence bounds are not plotted for the individual data sets. 
 
 

 
 
The ‘Likelihood Ratio Bounds’ tab shows a confidence ring around the parameter estimates, in 
this case the 90% confidence ring.  The individual data set parameter estimates are also 
plotted.  This graph basically combines the previous two graphs.  The rectangle around the ring 
defines the extremes of the ring.  These extremes are reported in the parameters section. 
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The ‘Parameters’ tab shows the parameter estimation results for the pooled data. 
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Time Dependent Data File Window – For each data set that is opened, a Time Dependent 
Data File Window will be displayed. 
 
The ‘Plot’ tab displays a graphical representation of the data set and its parameter estimates.   
 

 
 

 

Use the  icon to edit the chart.   

The Chart title, the X-axis title, and the 
minimum and maximum values for the X-axis 
may be modified.  The X-axis values must 
encompass the data. 

Clear the entry to reset any of the values to 
their defaults. 
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The ‘Parameters’ tab contains a printout of the calculated statistics along with the geometry and 
other options that were setup in the Analysis Options dialog for this data set.  The parameters 
are described below.  For further details please refer to the Time Dependent Theory Guide. 
 
N, D The specimen specific or raw data parameters.  N is the fatigue 

exponent and D is the Y-intercept. 
 
M, SP, N, B, Eff Weibull Slope, Weibull Material Scale, Fatigue Exponent, Fatigue 

geometry independent material parameter, and the Effective volume 
or area based on M and N, respectively. 
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The ‘Data’ tab displays the data file and provides access to editing the data through the 
Windows Notepad editor and subsequent refreshing (reanalyzing) of the data. 
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Generate Data Dialog – This dialog prompts the user for the input parameters necessary for 
the generation of a Weibull distribution failure data set.  The threshold value may be set to zero 
to simulate a two parameter Weibull distribution. 
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EXAMPLES 
 
Example files have been provided in the following directory: 
 
 <InstallDir>\examples\ 
 
Open the files in a text editor such as the Windows Notepad in order to view comments about 
each example.  Information such as specimen geometry is provided. 
 
 
Subdirectory File Description 
<InstallDir>\examples\…   
   
…\fast Uncen.dat Uncensored data set. 
 Uncen3a.dat 3 parameter uncensored 
 Uncen3b.dat 3 parameter uncensored 
 Censor.dat Censored data set. 
   
…\fast\pooled ss_3a.dat 3 point bend – geometry a 
 ss_3b.dat 3 point bend – geometry b 
 ss_3c.dat 3 point bend – geometry c 
 ss_4a.dat 4 point bend – geometry a 
 ss_4b.dat 4 point bend – geometry b 
 ss_4c.dat 4 point bend – geometry c 
 ten-1.dat Tensile specimen – geometry 1 
 ten-2.dat Tensile specimen – geometry 2 
 ten-3.dat Tensile specimen – geometry 3 
   
…\dynamic Dynamic.dat Uncensored Dynamic Fatigue 
 Fast uncen.dat Uncensored Fast Fracture Data 
 Fast censor.dat Censored Fast Fracture Data 
   
…\Jint JC-80.dat J-Integral data set. 

 
 
 
 
 
 
 
 


